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Paper Formatting and Source Use: A Quick Guide for Students 

Most students who have never taken the time to study an essay formatting style (or have never had 

the use for one) tend to get anxious when they hear they have to type papers in a particular style. When 

they hear that different disciplines have different styles and they may need to learn more than one, they 

also get anxious. For example, English, Literature, and other Arts-related disciplines typically use the 

Modern Language Association (MLA) formatting style; Criminal Justice, Psychology, and other Social 

Sciences disciplines typically use American Psychological Association (APA) style; History and other 

Humanities use Chicago Manual Style (CMS), which is sometimes referred to as Turabian format; and 

most physical and biological Sciences use College of Sciences (COS) style.  

As a professor who generally teaches lower level English classes offered to students of all disciplines 

(and as someone who once took the same classes as a student), I find all this rather troubling. Perhaps 

one of the main reasons is that most English professors only teach one of the various styles (the one they 

use in their discipline) and never mention the others. That doesn‟t help all the students whose major 

discipline uses a different formatting style. Luckily, most Theological Studies programs allow students to 

use several styles, as long as said students use only one style throughout an entire paper. 

Yet since I do generally teach the English courses (and my one Theology program permitted me to 

use my major discipline‟s style), I usually provide an in-depth guide to using that discipline‟s style. For me, 

that‟s MLA, and this essay you‟re reading not only describes MLA formatting but offers an example of it. 

Even if you will not use MLA, I suggest you read this essay because most of the basic formatting 

information applies to other disciplines. For those of you who do intend to use a different discipline‟s style, 

I ask that you email me later so I may send you a copy of this same essay in your preferred style. If you 

need further assistance, you can find most of this information in writing handbook sources or online web 

resources. In any case, I suggest you invest in a writing handbook such as The Scott, Foresman Writer 

which covers all major discipline styles as well as provides a good deal of information regarding Standard 
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Written English (SWE) and academic essay construction. If you are more tech-savvy and prefer “free” 

resources, one website that contains most of the same information (regarding formats, SWE, and essay 

construction) is the Online Writing Lab at Purdue University. (See the Works Cited information at the end 

of this essay for information regarding both.) 

When you start out to write a paper in any formatting style, you should immediately go to the word 

processor's page formatting menu. Most students these days use Microsoft 2007, although some now 

have MS 2010. These are the most recommended because most schools use these programs. Sometimes 

students like to work from home and therefore either use these or a different program that lets them save 

files as MS-Word compatible. Since the most recommended and used is MS Word, I'll offer the formatting 

information below for MS Word 2007. For the others, such as Open Office Writer, you'll need to consult 

the Help menu in those programs. (Again, the following information regards MLA formatting style.) 

First, as I mentioned above, you'll need to go to MS Word 07's page formatting menu; this is under 

the tab labeled "Page Layout”. Immediately set your margins to 1-inch all-around. Do so by clicking on 

the margins icon and selecting the 1-inch margins option. If that option is unavailable, you'll need to 

access the "custom margins" section at the bottom of the margins tab and type in your desired margins. 

Next, again before actually typing, in the page layout tab find the section marked "Paragraph". First 

make sure that all of the categories are set at zero (sometimes, the program automatically inserts an 

extra 1.15 or more line spaces between paragraphs; however, that's not proper MLA format), then click 

on the square-arrow icon in that paragraph section. This action should open a paragraph pop-up menu. 

Again, double check to ensure everything is set to zero. Then, and this is most important, click on the 

"Line Spacing" tab and select "double". Click "OK" at the bottom and you're set. (If the paragraph tab is 

not there, hover your mouse icon over the blank page, click the right button, left-click the option for 

paragraph, and follow the rest of the guidelines above.) 

You also need to ensure you use the proper font and font size, so next hover your mouse icon over 

the blank page, click the right button, and then left-click on the "Font" selection. MLA formatting allows for 

different font/size choices, but the most standard is Times New Roman font, size 12. This sentence is 

presented in TNR 12. The second option is Arial font, size 10. (The whole of this document, except the 

TNR 12 sentence, is presented in Arial 10.) Make sure before exiting the "Font" menu that there are no 
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special circumstances (such as bold, italics, small caps, etc.) selected for the text, so it appears "normal". 

Click “OK” when you are done. 

At this point, you should have the basics of page formatting down in MS Word 2007: one-inch 

margins on all sides, line spacing set only at double, and the font selection of Times New Roman 12 or 

Arial 10. After completing those basic set-up options, it's a good idea to save the document. Do so by 

clicking on the MS Orb in the top left corner and selecting "Save As". Under the "Save As", click MS 

Word document. All of this formatting setup may take a while the first few times you do it, but the more 

you engage in the task, the easier it becomes. One way to ease the process: follow all of the above 

steps and save the document as “Basic MLA Setup”. Afterwards, you can simply open this document for 

any paper you begin to type, click the “Save As” button, and change the name of the document to 

whatever course/essay designation you wish.  

Now you are ready to begin your essay—sort of. Follow the example of this one. The first thing you'll 

want to do is set your header. A header appears in the top right corner and contains your last name and 

the page number. The easiest way to access the header section in MS Word is to hover your mouse icon 

in the near the top edge of your page and double-click the left button. When you do so, the header 

section should appear (and above, the "Design" tab should be opened). If it doesn't, try again in another 

location a little to the left or right. Next, find the "Header & Footer" section of the menu; generally, it's on 

the left. Click on the "Page Number" tab, hover over "Top of Page", then click on the example that shows 

the page number aligned on the right side of the page (MS Word generally refers to this as "Plain 

Number 3"). The page number should appear and the typing cursor should blink beside of it. Make 

sure the cursor is to the left of the number. Type in your last name and then hit the spacebar once (so 

that the header now appears as your last name, space, page number). When you are done, click the 

mouse cursor somewhere in the main part of the page outside the header; if you've followed these 

directions on a new blank document, your typing cursor should now blink at the left-top of the page again 

(below the header) Your header should be set, just double-check the font and size. Sometimes it's set 

wrong. You may need to highlight it, right-click to access the "font" tab, and set it appropriately. (As you 

type your paper, you'll note that once you get to page two, your header will change; it should still have 

your last name, but the number will change to "2". It will do that on every page.)  
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Next step: follow the example above and create a four-line heading. Such a heading includes (in this 

order) your name, the class and number, the instructor's name, and the date you type the paper. 

Remember that these things are left-aligned. Only the header above, not the heading or the rest of 

the paper, should be right-aligned. The simplest way to align something to the left is holding down the 

"Ctrl" button on your keyboard and, simultaneously, pressing the "L" button. 

On the next line, you need your essay's title. This is the only other "oddly aligned" item in your paper. 

It's centered. So when you are on the line below the four -line heading, simply click "Ctrl" and "E" 

together and the cursor should appear blinking at the center of the page. Next, type your title. 

Remember that the title is for your paper and about the subject of your paper. Sometimes, students think 

a title for a paper is the type of paper, leading them to use “Description” or "Narrative Essay" or 

“Exegesis” as the title. But that's not a title, that's a type. Avoid using such as a title. Think about any book 

you've read for fun. What if every single book on the shelf was titled Novel or Fiction or Text Book? It tells 

you nothing about the contents. Same holds true for any essay you write. It needs a proper title. 

Finally, move to the next line to begin the first paragraph of your essay. Click "Ctrl" and "L" together 

to get the text left-aligned. When you create a paragraph, make sure to indent only five spaces. That 

means click the spacebar five times; students generally confuse this with clicking the "tab" button (but 

that's because the tab used to be set at 5 spaces; now, it's like 10 or 15 and inappropriate for MLA). 

One more suggestion for you prior to writing, although you can use this as a follow-up technique in 

the revising process: ensure that your word processor‟s grammar/spelling check program is set to catch 

everything. To do so, simply move up to the MS Orb and select the “Options” menu. Once there, find the 

editing or grammar/spelling selection. Once that menu opens up, you can change the preferences for 

checking specific errors. Also, note that MS Word runs a default program to check what it refers to as 

“Grammar.” You need to make sure your program checks “Grammar and Style” and that all options are 

selected. The reason: what MS Word creators refer to as style, professors consider grammar.  

Now you truly have completed the basic set up, so again save your document. Follow all of the 

above steps and save as “Basic MLA Setup”. When you are ready to type an actual essay, “Save As” a 

new name. Typically, a default suggestion is last name, semester or quarter, class designation, and 

either the essay number, type, or brief working title. Doing so helps you remember what your file is, 
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especially if you do not have specific class folders set up on your own computer or thumb/flashdrive or 

you are using someone else's or a school computer. Examples include "Smith.FA10.Eng101.E1" or 

"Smith.SP11.Theo580.Exegesis.John3".  

     Once you actually begin writing your essays, you‟ll find at some point you need to incorporate source 

information. Wise people say “You should know your limits.” This is true of all writers, but most especially 

true of beginning academic writers. In particular, beginning writers know that the world for which they 

write will do the limiting for them if they begin to perceive themselves as (to use a cliché) “wiser than their 

years.” One way to avoid such concerns is in acknowledging that you do not know enough about anything 

to speak for yourself and must therefore rely on sources. As Gary Goshgarian notes in Dialogues: An 

Argument Rhetoric and Reader, most essays “derive their success from the evidence they contain, so 

good writers learn to find evidence in many sources and present the best evidence to support” their work 

(203). By best evidence, academic and professional researchers mean evidence that is relevant and 

reliable, particularly in regard to purpose, audience, and genre. In other words, it must not only be on 

topic (relevant), but it must trustworthy (reliable) as well.  

     For example, an article about cancer by a doctor or an oral history by a cancer survivor may be 

considered best evidence. But although sources may contain topic-related information, if they are of the 

National Tattler caliber, they won‟t do. An article entitled “Bat-boy Overhears Cancer Cure With 

Supersonic Ears” is neither reliable nor best even if the information about cancer the so-called batboy 

overheard came from doctors at the Mayo Clinic. For an example more related to our purposes, consider 

writing an exegesis on one or more Psalms. Best evidence in this case would include multiple Psalm 

translations, commentaries, and articles/books by well-known theologians; use of such source material 

coupled with your own perspective would be much more valuable to you and your audience.  

     The idea here is to incorporate source material from good sources instead of bad ones. Good sources 

include but are not limited to original documents, translations, professional articles/books/commentaries, 

and even surveys and interviews conducted by professionals or those professionally conducted by you. 

Bad sources include but are not limited to all ultra-biased or highly opinionated sources (those that rely 

more on emotion than logic or ethics), personal emails or “forwards” (FWDs) where validity is questioned 

(e.g., “FWD: This is a True Story, Verified by Snopes”), and, as mentioned above, examples of “yellow 
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journalism”. One more bad source choice involves the use of Wiki-related web materials. The reason why: 

a lot of this information goes unchecked/unverified and may not be accurate or even true—even on 

Religion wikis. (A good example of the shoddy evidence gathering comes from John Siegenthaler, who 

wrote an article entitled “A False Wikipedia „Biography‟.” In it he discusses how Wikipedia‟s bio of him 

said he was “directly involved” in the assassination of RFK (par 1). This suggests he is suspect. In fact, he 

was a top advisor, was present at the time, and asked for a report of the incident. Such info is misleading, 

and most people will take the mislead as truth. Wikipedia had no way to track the source and took many 

months to remove/rephrase the false information, although Siegenthaler was on their case nearly every 

three days.) So, do your best to avoid such sources, especially for academic papers. 

Here‟s something else fundamentally important to keep in mind: anything you use that you did not 

originate is source material; if it is source material, you must include source reference information. If you 

do not, you are committing plagiarism whether you intend to or not. This is something even pastor‟s who 

speak and profess the Word of God need to consider; in fact, you are perhaps in a position where being 

humble and respectful and acknowledging assistance is required and expected the most. One thing to 

keep in mind is the academic rule of thumb about plagiarism, which I use with my English students: if 

you seek assistance outside of your own experience after you begin a classroom assignment (or simply 

begin a new writing), you are using sources and must reference them.  

For example, say you choose to write a paper about a story your Grandma told you as a child. If you 

remember the story, you can write it and you are your own source; if you‟d like, you can simply include 

“One time my Grandma told me this story,” but you don‟t necessarily need to acknowledge Grandma. 

However, if you forget important details and have to call a parent, sibling, or cousin (or even Grandma) 

for more information, you have consulted a source and must acknowledge that source. In essence, you 

have conducted a personal interview.  

The same holds true for pastors, even in sermons. I mean, really, would you quote or reference a 

passage of scripture without telling your audience where in the book it‟s located? Another example: A lot 

of pastors like to use sermon illustrations or personal anecdotes in their oral presentations; I have heard 

quite a few in my time. If the events described actually happened to you or you have a creative mind 

(making up your own little story), that‟s great; no outside sources have been used. But if you borrow 
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something from Chicken Soup for the Soul or even one of those multiple-times forwarded emails, you 

need to let your audience know—not only because it‟s good for them and you to acknowledge source 

assistance but also because it is disingenuous to let your audience believe you created or experienced 

something you did not create or experience. (Personally, as an educated person, I start to question a 

pastor‟s leadership role if I hear the pastor repeat a story I read online or in a book and he or she 

passes it off as something they experienced. Reread your New Testament; the writers of the epistles 

and even Jesus—the Word himself—quoted and acknowledged sources, even the scriptural ones.) 

So you really must include source reference information along with whatever paraphrases or 

quotations you use in the body of your essay and provide a bibliography at the end. In MLA formatting 

style, the in-essay references include attributions, paraphrases or quotes, and citations while the end-

essay bibliography (known as a Works Cited page) includes a full account of author, title, and 

publication information. For example, say I would like to give a strong definition of plagiarism and I look 

it up in Merriam-Webster‟s online dictionary. In my syllabus, I might write the following: Defined by 

Merriam-Webster as “the act of using another person’s words or ideas without giving credit to that 

person” (par 1), plagiarizing is the most unethical action you could take in this course—and the most 

grade-fatal. The introductory phrase, “Defined by Merriam-Webster,” is an attribution; “the act” through 

“that person” is a direct quote; and “(par 1)” is the citation. (In most cases, a citation contains the page 

number(s) from which the quote is borrowed; however, when using an online source that doesn‟t have 

page numbers, you cite the paragraph(s), hence “par”.)  

Now that‟s just the in-essay source usage and documentation. I (and you, of course) would still need 

to create a bibliographic entry that contains even more source information. For this example, I would 

need the web page and site titles, the publication information, identification of the source as a Web 

source, and the date I accessed the information. I would then create a page at the end of the essay 

entitled “Works Cited”. (The easiest way to do so begins with creating a “page break” at the end of the 

essay (after the conclusion paragraph). (In MS Word 2007, I/we would hover the blinking cursor after 

the conclusion, then use the arrow cursor to click on the “Page Layout” tab, the “Breaks” icon, and the 

“Page” break selection.) After that, I would create a title for the page (Works Cited) and align it in the 

center. Finally, I would input the source information.) As with the rest of the essay, the Works Cited 
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page should retain the same alignment and spacing. However, note that on a Works Cited page the 

indentation is different. The first line is left-aligned and not indented, and any secondary lines are 

indented five spaces.  

The easiest way to format the indentations is as follows: a.) Simply type the information, keeping all 

text left-aligned. b.) Note if the text goes over one line, we need to indent the secondary line or lines 

(second, third, etc.). c.) Look up to the ruler bar at the top of your page. On the left, we see two carrot 

markings and rectangular marking. The two carrots are inverted (the top facing down, the second facing 

up), and the rectangle sits below both of them. d.) Hover the arrow cursor over them all for a few 

seconds. Notice the information: the “down carrot” is called “First Line Indent”, the “up carrot” is called 

“Hanging Indent”, and the rectangle is called “Left Indent”. e.) Move the cursor back down to the essay 

and highlight the secondary line(s) of the entry (do so by clicking (and holding) the left button and 

dragging the cursor across all the text in those secondary lines, then release after the last word or 

punctuation mark). f.) Move the cursor up to the “up carrot”, hover until “Hanging Indent” appears, then 

click and hold the left button. g.) Drag the “Hanging Indent” carrot over until it rests approximately five 

spaces in (the same indentation length of the first lines of paragraphs). h.) Release the button. If you 

have followed these steps correctly, your secondary lines should be indented and appear as mine do in 

my own Works Cited page. 

     Generally, the Works Cited entries appear in alphabetical order based on the first “field” (or “part” of 

the entry) presented. Usually, the first field is an author‟s name in the format of “last name, first name”. 

However, some sources, like the one above, do not have an author. If that‟s the case, begin the entries 

with the next “field” (the next part of the entry). One important thing you need to remember about 

whichever formatting style you choose: the citation and bibliographic information depends on the type of 

source you use. Usage of different sources (books, magazines, online academic journals, personal 

interviews, films, lyrics, etc.) all require slightly different information. Seek assistance in a handbook or 

website (such as those mentioned above) or even your word processor‟s Help Menu and Tools for 

determining which type of reference is required. (In MS Word 2007, you also can enter the “Reference” 

tab menu and select MLA, APA, or CMS bibliography setup for even more direct assistance, but I‟ll let 

you figure out how to engage that one on your own.) 



Jarrett 9 

 

 Personally, I think that about wraps up your introduction to using MLA Style. I began with 

generalized introductory information on various formatting styles and then specified a discussion of 

MLA; in doing so, I also presented a decent thesis statement: “this essay you‟re reading not only 

describes MLA formatting but offers an example of it.” Afterwards, I offered in-depth page formatting and 

source usage guidance accompanied by examples; as I introduced each new body paragraph, I offered 

either a lengthy or short transition from the previous one, presented a topic sentence covering the 

content of the paragraph, and followed that with a series of sentences expanding on that topic sentence. 

Finally, I wrote this poor attempt at a conclusionary paragraph; for the most part, it does “do” what a 

conclusion should do: remind the readers of what they‟ve come through to get this far by first 

readdressing the thesis statement and second summing the subject matter. The only part I left out is the 

final aspect of a good conclusion: offering another insight. So . . . here it is: Remember, this essay I‟ve 

written not only offers a step-by-step process guide but also follows the basic MLA formatting style. 

Again, I acknowledge it is basic. If you find any of this confusing, I suggest the following course of 

action: First, reread it slowly. In doing so, open up your word processor and try going through the 

process as you read. Second, if you need more assistance, access a handbook or website mentioned 

herein. Third, compose an inquiry email and send that puppy in my direction. I‟d be happy to assist.  

Just keep in mind, in regard to the third step, I ask you to do your best to avoid acting like my 

average undergraduate student: please do not send the email less than 48 hours before a paper is due 

and expect both a) a response that gives all the spoon-feeding needed (although it probably will) and b) 

a certitude of competently completing the work in that short time. Oh, and, again like my undergrads, 

please don‟t believe that it‟s all my fault the student waited until “the last minute” to ask a question (or 

begin a paper) and because I didn‟t respond in time the paper went unfinished or I caused it to get a low 

grade. (My apologies. Perhaps that‟s a little more insight than you bargained for. I guess I simply had to 

get that off my chest . . . and where better could I do that than in a room full of pastoral counselors?) By 

the way, I also left a few typos in this here thing, such as switching between straight and curly quotation 

marks, all in an attempt to remind you that no draft is ever flawless and can always take revision. As we 

all know here at Course of Study, nothing produced by the human hand is perfect; as we strive to move 

on to perfection, we should strive to ensure our writing does, too, as long as we accept some flaws. 
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End Notes

Mark
Text Box
There have been some modifications to MLA Format since the original draft of this essay, particularly in regard to the Works Cited page.  You can find those updates in the latest pdf version of the the Power Point slideshow used during COSWV Writing Workshops or at the Purdue OWL.  


